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1. Introduction
Th ank you for purchasing Decagon Devices’ ProCheck. 
Th e ProCheck is a device used to interface with your analog 
and digital soil moisture sensors and obtain instantaneous 
results. Th is manual will help you understand the functions 
of and get the most out of your ProCheck device.

 Customer Support
If you ever need assistance with your ProCheck or if you 
just have questions or feedback, there are several ways to 
contact us.  Customer service representatives are available u 
Monday thru Friday, between 7am and 5pm Pacifi c time. 

NOTE:  If you purchased your ProCheck through a dis-
tributor, please contact them for assistance.

E-mail:
support@decagon.com

Phone: 
1-509-332-5600

Fax:  
1-509-332-5158

If contacting us by e-mail or fax, please include as part of 
your message the equipment in reference, your name, ad-
dress and phone.    You can also send feedback to Decagon 
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using ECH2O Utility “Send Feedback to Decagon” feature. 
See Appendix B for more information.

 Warranty
Th e ProCheck is covered by a standard, one-year warranty 
on parts and labor, and is activated upon the arrival of the 
instrument at your location.

 Repair Instructions
If your ProCheck should ever require servicing contact sup-
port@decagon.com or call Decagon at (509) 332-5600. We 
will ask you for your address, phone number, and your Pro-
Check serial number. 

Before shipping your instrument to Decagon, please 
contact Decagon to obtain a Return Merchandise Au-
thorization (RMA) number. Th is will allow Decagon’s re-
pair staff  to keep track of your ProCheck. Once you have 
acquired an RMA, send your ProCheck to Decagon. Please 
include a document listing the complete shipping address, 
name, and department of the person responsible for the 
instrument, as well as a description of the problem. Th is 
will better help our technicians and shipping department 
to expedite servicing on your ProCheck. 

Please pack your ProCheck carefully. Ship it back in the 
carrying case, preferably inside a cardboard box. Ship to:

Decagon Devices, Inc.
RMA# (insert number here)

2365 NE Hopkins Court
Pullman, WA 99163
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Repair Costs
Manufacturer’s defects and instruments under warranty 
will be repaired at no cost. For non-warranty repairs, costs 
for parts, labor, and shipping will be billed to you.

Seller’s Liability
Seller warrants new equipment of its own manufacture 
against defective workmanship and materials for a period 
of one year from the date of receipt of equipment (the re-
sults of ordinary wear and tear, neglect, misuse, accident 
and excessive deterioration due to corrosion from any cause 
are not considered to be a defect); but Seller’s liability for 
defective parts shall, in no event, exceed the furnishing of 
replacement parts f.o.b. the factory where originally manu-
factured. Material and equipment covered hereby which is 
not manufactured by the Seller shall be covered only by 
the warranty of its manufacturer. Seller shall not be liable 
to Buyer for loss, damage, or injury to persons (including 
death), or to property or things of whatsoever kind (includ-
ing, but not without limitation, loss of anticipated profi ts), 
occasioned by or arising out of the installation, operation, 
use, misuse, non-use, repair, or replacement of said mate-
rial and equipment, or out of the use of any method or pro-
cess for which the same may be employed. Th e use of this 
equipment constitute’s Buyer’s acceptance of the terms set 
forth in this warranty. Th ere are no understandings, rep-
resentations, or warranties of any kind, express, implied, 
statutory, or otherwise, (including, but not without limita-
tion, the implied warranties of merchantability and fi tness 
for a particular purpose), not expressly set forth herein.
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2.  About the ProCheck

The ProCheck is a hand-held readout device designed 
for use with all soil moisture sensors and environ-
mental monitoring sensors made or sold by Decagon.

Specifi cations
 Battery Type: 4 AA

 Battery Life: 500-1000 Hours Expected

Connector Type: Stereo Plug (3.5mm)

Memory: 5000 individual readings

 Components
 • ProCheck Hand-held reader
 • Serial (RS-232) to USB Cable
 • Manual
 
Optional - Pigtail adapter
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3. The  Buttons

MENU is used to turn on the 
ProCheck and cycle through the  
menus at the top of the screen. Hold-
ing MENU down for 3 seconds will 
turn the power off. Pressing MENU 
in an annotation/edit screen will re-
turn to the previous screen.
SAVE is used to save setting changes 
to the instrument and annotate read-
ings.
ENTER is used to choose options 
within menus, start readings, and 
scroll to the right in an annotation/
edit menu.
ESC is used to cancel setting chang-
es, cancel readings, and scroll to the 
left in an annotation/edit menu.

The UP and DOWN arrows are used 
to scroll through sensors and menu 
options, as well as change charac-
ters and numbers in the annotate/edit 
menus.
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4. The Menus

The Main Menu

The ProCheck features three main menus designed for 
ease of use. The ProCheck displays the Main Menu 
when fi rst powered on. This menu is used for taking the 
measurements with Decagon’s sensors.

Changing Your Sensor
You can change your sensor type by pressing the up and 
down arrow keys if the sensor list spinner is available.

NOTE: You can customize the sensor units and calibrations in the Con-
fi guration Menu. Th e sensor version is only shown if the ProCheck was 
able to retrieve sensor information directly from the sensor. A soil cali-
bration type is displayed only if it is available for that sensor type.
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Taking a Reading
To take a reading, scroll through the sensor list until you 
fi nd the sensor type you want to read. Plug the sensor 
into the stereo jack on the top of the ProCheck. 

Press ENTER to start the live update mode. A live up-
dating icon is displayed in the lower right corner. The 
ProCheck will continuously update the screen with the 
latest sensor reading. Press ENTER again to restart the 
sensor. Press ESC to exit the live update mode. Press 
SAVE to save the current reading on the display. From 
the save screen you may annotate your reading.

 Annotating a Reading
Once you have taken a reading, press SAVE to show 
the annotation screen. The left side of the screen 
shows a reading summary and the right side of the 
screen shows the annotation fi eld as well as the date 
and time the reading was taken.

Use the up and down arrow keys to change the current char-
acter and use the left and right arrows to change the cursor 
position. Press SAVE to save the annotation and MENU to 
return to the main screen without saving the record.
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NOTE: Th e ProCheck will remember the last annotation 
stored into memory. You can clear all or part of an old annota-
tion by pressing the up or down arrow key. Th is will clear all 
the characters to the right of the current cursor position.

The Confi guration Menu
To navigate to the Confi guration Menu, press MENU un-
til the Confi guration tab is highlighted. Several different 
options are available for customizing the instrument.
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Units Sub Menu
From this menu you can confi gure your unit preferences 
for various unit types.    

Use the up and down arrows to navigate to the unit you 
would like to change and press ENTER to cycle through 
the diff erent types.

Th e “Show  Unprocessed Data” option allows you to view 
any formatted data in its raw analog to digital count (ADC) 
state instead. When this option is checked, all data read-
ings on the main and data screens are displayed in an un-
processed format as seen on the following screen. Th is can 
be helpful when troubleshooting sensors or when creating 
your own custom calibration. To save your changes, press 
SAVE. To cancel without saving, press ESC.
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 Calibration Type Sub Menu
Some sensors support a calibration adjustment for dif-
ferent media types (soil, rockwool, etc.). Th e fi rst screen 
shows a summary of the selected soil calibrations for each 
confi gurable sensor.

To modify a sensor’s calibration type, press ENTER. You 
can choose a preset soil calibration type or create your 
own (See creating a Custom Calibration). To change the 
soil calibration type, press ENTER when the medium op-
tion is selected. You can view the calibration coeffi  cients 
by pressing ENTER when the coeffi  cients option is high-
lighted. Press SAVE to save your calibration preference or 
press ESC to exit without saving changes.
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Below is a list of sensors that support soil calibrations.

Sensor Name Supported Medium Calibrations

EC-20 Soil Moisture Mineral, Custom

EC-10 Soil Moisture Mineral, Custom

10 HS Soil Moisture Mineral, Custom

EC-5 Soil Moisture Mineral, Potting, Rockwool, Perlite, Custom

ECH2O-TE Moisture, 
Temp, EC

Mineral, Potting, Rockwool, Perlite, Custom

EC-TM Moisture, Temp Mineral, Potting, Rockwool, Perlite, Custom

5TE Moisture, Temp, EC Mineral, Potting, Rockwool, Perlite, Custom

5TM Moisture, Temp Mineral, Potting, Rockwool, Perlite, Custom

GS3 Moisture, Temp, EC Mineral, Soilless Substrate

RS3 Moisture, Temp, EC Mineral, Soilless Substrate

NOTE: With the 5TE and 5TM sensors (only), cus-
tom calibration equations must be constructed with a 
(dielectric permittivity) as the ‘x’ variable.  With the 
ProCheck and other Decagon data acquisition equip-
ment, a = Raw/50.  With other data acquisition 
equipment, if read in SDI-12 mode, a = Raw/100.
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Creating a  Custom Calibration
You can create your own custom calibration for certain sen-
sor types. A custom calibration is applied directly to the 
raw analog to digital count (ADC) in the form of a fi fth 
order polynomial.  For more information on creating a cus-
tom calibration, please refer to the literature section of our 
website at www.decagon.com for an Application Note.

NOTE: Custom calibrations are in terms of m3/m3. Unit 
conversions are applied after the custom calibration is applied.

Entering a Custom Calibration
To enter your custom calibration into the ProCheck, navi-
gate to the Calibration Type sub menu (in the Confi guration 
Menu) and select a sensor. Press ENTER until the medium 
type says Custom. Th en press ENTER on the coeffi  cient op-
tion to get to a summary screen like the one below.

Each  coeffi  cient corresponds to a letter in the polynomial 
above. Below the polynomial is the value of each coeffi  cient 
in scientifi c notation. To edit a coeffi  cient, press ENTER 
when the desired coeffi  cient is highlighted. You will see a 
screen like the one below.
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Use the up and down arrow keys to change the current value, 
use the left and right arrow  keys to change the cursor position. 
Press SAVE to save the coeffi  cient and MENU to return to the 
coeffi  cient list without changing the coeffi  cient.

Once you’ve changed all of the coeffi  cients, press SAVE again 
to save the custom calibration or ESC to return to the Calibra-
tion Type sub menu without saving the calibration.

 Sensor List Sub Menu
You can customize which sensors you would like available 
on your main screen here.

Navigate through the sensor list using the up and down ar-
rows. To change the status of a sensor, highlight it and press 
ENTER. If the sensor name is checked, it will be included 
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in the list on the main screen. If it is unchecked it will 
be excluded. You can use the “Check All” or “Un-check 
All” options to enable/disable all the sensors at once. Press 
SAVE to save your changes or press ESC to exit without 
saving.

 SDI-12 Address Menu
Intro to SDI-12
SDI-12 stands for serial data interface at 1200 baud. Th is 
standard was created to interface battery powered data 
recorders (loggers) with micro-processor based (intelli-
gent) sensors designed for environmental data acquisition 
(EDA).  Please see www.sdi-12.org for more information 
on using SDI-12.

Decagon’s digital soil moisture sensors communicate us-
ing both the SDI-12 standard and Decagons proprietary 
protocol.  Th is SDI-12 feature is not necessary when using 
Decagon sensors with Decagon data loggers.  But, SDI-12  
may be useful if you are using the sensors with other third 
party data acquisition systems such as Campbell Scientifi c 
data loggers.  For more information, refer to the sensor’s 
integrator’s guide. 

One feature of the SDI-12 protocol is the use of a single 
character sensor address.  Th is character may consist of “0” 
(default) to 1-9, a-z, or A-Z.  Th is address is necessary when 
multiple sensors are installed at a single site.  Th is is impor-
tant because you will need to assign each sensor a diff erent 
address thus allowing you to keep their data separate. 
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Setting SDI-12 addresses
Th e ProCheck may be used to conveniently assign SDI-12 
addresses to the Decagon digital sensor.  To assign the ad-
dresses, follow the instructions below:

1. Use the pigtail adaptor to connect a SDI-12 compat-
ible sensor to the ProCheck’s stereo jack.  

2. In the Confi guration menu, select SDI-12 Address.  Once 
selected the following screen will appear.  Th e screen will 
refresh with the sensor’s current confi guration.

3. Press the up and down arrows to select the new address 
from “0” (default) to 1-9, a-z, or A-Z.  

4. Press ENTER or SAVE to accept new address.  Screen 
will refresh showing new address setting.

5. Press ESC or MENU to exit the SDI-12 Address Sub 
Menu. 

Note: If you plan on setting addresses on multiple sensors, 
repeat the steps 1 through 4 before proceeding to step 5.
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 Date and Time Sub Menu
To set the date/time on the instrument you can connect 
to ECH2O Utility and select the “Set Date/Time” option 
under the actions menu, or you can follow the instructions 
below to manually update the date and time:

1. Scroll to the Date Option in the Confi guration Menu 
and press ENTER. You should see a screen similar to 
the one above. A pair of arrows will be present above 
and below the fi rst value.

2. Use the up and down arrow keys to change the current 
value. Press ENTER to move to the next value or press 
ESC to return to the previous value. (Hold down the 
up/down arrows to scroll quickly).

3. Press SAVE to save your changes.

Contrast Sub Menu
Th is menu allows you to alter the screen lighting  contrast 
settings. Scroll to the contrast option in the Confi guration 
Menu press ENTER. 
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Use the up and down arrows to change the contrast. Press  
SAVE to save the contrast or press ESC to exit without sav-
ing changes.

About Sub Menu
Th is menu displays your ProCheck’s serial number, device 
name and fi rmware version.

The Data Menu
To navigate to the Data Menu, press MENU until the Data 
Tab is highlighted. Several diff erent options are available 
within this menu. With the ProCheck you can store up to 
5000 individual readings.

Number of Readings Taken        Maximum Number of
                                                             Readings
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View Sub Menu
You can view a summary of your saved data or view de-
tailed information about any data record. Th e fi rst screen is 
a summary screen and looks similar to the picture below.

Th is page shows a data record list that includes the date and 
the time that the reading was taken and the annotation (if 
any). To view more information about an individual re-
cord, press ENTER while that record is highlighted. (See 
screen below).

Th e left side of the screen shows a reading summary and 
the right side shows the annotation, date, and time that the 
reading was taken. From this screen you can press ESC to 
return to the previous view screen or use the up and down 
arrow keys to view more records in detail.
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 Statistics
You can collect summary statistics, including average and 
standard deviation, from measurements taken with your 
ProCheck.  To collect summary statistics on a series of mea-
surements, go to the “Statistic” menu. 

Using the “up” and “down” arrows, ensure that you have 
the correct sensor selected.  When you press “Enter”, the 
connected sensor will show you the current reading on the 
left hand side of the screen.  

On each subsequent “Enter” keypress the measurement taken 
will be included in the summary statistics.  Th e “n” value rep-
resents the number of measurements taken as part of the sum-
mary statistics.  Press “ESC” once to stop live updating and 
press “ESC” a second time to reset the statistical information.
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You can save the summary statistics by pressing the “save” 
button.   However, this does not reset the “n” value so you 
can continue to make measurements.  Th e “save” button 
only saves the summary statistics and not the data that was 
used to calculate the values.

Downloading Data
Your ProCheck comes with ECH2O Utility software for 
Microsoft Windows. Th e Utility makes  downloading data 
to your computer very easy. In general, you should use the 
ECH2O Utility to download data instead of the menu op-
tion in the ProCheck. 
 
Note: You must install the USB driver before connecting the USB 
Cable to your computer.  You can install from the CD included 
with your ProCheck or download at www.decagon.com/support.

Th is menu option sends the data saved in the ProCheck to 
the terminal software running on your computer.

1. Confi gure your  terminal software with the following 
settings:

 • 9600 baud
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 • 8 data bits, 1 stop bit, no parity
 • No software/hardware fl ow control
 • Append line feeds to incoming line ends

2. Connect your ProCheck to an available USB port on 
your computer using the included RS-232 to USB 
cable.

3. Set your terminal software to capture received data if 
you want to save the data.

4. Select “Download” from the Data Menu of the Pro-
Check.

Erasing Data Memory
WARNING! Once this feature is activated, all data will 
be permanently deleted from the ProCheck, and cannot 
be recovered.

To erase your data, do the following.

1. Navigate to the Data Menu in the ProCheck.

2. Select the  Erase option.

3. Press ENTER on the Erase Data Memory screen.
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5. ECH2O Utility Software

 ECH2O Utility is the software interface for downloading 
sensor measurement data stored in your ProCheck. You 
can choose to save your data as an Excel Workbook fi le, 
tab-delimited text fi le, and a Raw, unprocessed data fi le. 
ECH2O Utility also helps you delete measurement data 
stored in your ProCheck and set the date and time in your 
ProCheck.

NOTE: ECH2O Utility is designed to work with your Pro-
Check and Decagon’s line of ECH2O loggers. Some non-ap-
plicabel controls, features and settings of ECH2O Utility are 
disabled when connected to a ProCheck.

Minimum computer requirements:
 • Windows 98 or newer, including Windows 7
 • Available serial port (or USB-to-serial adapter)
 • MS Excel 97 or newer (if saving data as XLS fi les)

 Installation
Th e ECH2O Utility installer software is located on the 
CD-ROM that shipped with your ProCheck instrument. 
You can also download the latest version of ECH2O Util-
ity from Decagon’s website: http://www.decagon.com/sup-
port/downloads.  

Note: You must install the USB driver before connecting the 
USB Cable to your computer.  You can install from the CD 
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included with your ProCheck or download at www.decagon.
com/support.

Connecting to your ProCheck
ECH2O Utility needs to establish a communication  con-
nection with your ProCheck to perform any of its func-
tions. To connect to your ProCheck, do the following:

1. Launch ECH2O Utility.

2. Use the supplied RS232 serial to USB cable to physi-
cally connect your ProCheck to an available USB port 
on your computer. 

3. Choose the correct USB (COM) port from the Con-
nect Via control in the toolbar that matches the physi-
cal port you chose in step 2.

4. Click the Connect button in the toolbar.

Once ECH2O Utility establishes a connection with the 
ProCheck, you should see the ProCheck’s name, serial 
number, fi rmware version and date & time settings.

1. Connect ECH2O Utility to your ProCheck.

2. Click the Download button in the toolbar. You can also 
choose Download All Data from the Data Menu.

3. ECH2O Utility opens a standard File Save dialog. 
With this dialog, you can name your data fi le, select 
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where it will be saved on your computer, and choose a 
fi le format for the saved data.

4. Click the dialog’s Save button to start the download. 
ECH2O Utility will show the progress of your down-
load.

NOTE: You can cancel a download in progress using the Can-
cel button. ECH2O Utility doesn’t create a data fi le if you can-
cel the download.

Saved Data Filetypes
By default, ECH2O Utility saves measurement data as an 
Excel Workbook fi le. Each of the  fi le types are discussed 
below.

Excel Workbook (*.xls): ECH2O Utility saves your mea-
surement data on Sheet 1 with the following columns:
 • Measurement Time: Date and time when the 
  ProCheck made the measurement.
 • Sensor Name: Type of sensor used for the measure-
  ment.
 • Measurement 1: Primary measurements made by
  the sensor.
 • Measurement 2: Some sensors support two mea-
  surements.
 • Measurement 3: Some sensors support three mea-
  surements.
 • Sample ID: Th e optional annotation saved at the  

   time of measurement.

ECH2O Utility saves the raw data for each measurement 
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on Sheet 2. Th is information includes the calibration co-
effi  cients used to calculate your data (for applicable sen-
sors). You can use the raw data for the sensor to apply a 
diff erent calibration if needed. Th is sheet has the following 
columns:
 • Measurement Time: Date and time when the
  ProCheck made the measurement.
 • Sensor Name: Type of sensor used for the mea-
  surement.
 • Unprocessed 1: Raw data for measurement 1
 • Unprocessed 2: Raw data for measurement 2.
 • Unprocessed 3: Raw data for measurement 3.
 • Sample ID: Th e optional annotation saved at
  the time of measurement.
 • Calibration: Th e calibration used for soil mois-
  ture sensors.
 • Coef a to Coef f: Th e calibration coeffi  cients
  used to calculate the measurement data.

 Processed Data Text File (tab delimited)(*.txt): Th is fi le 
format creates a tab delimited text fi le of your measure-
ment data. Th is fi le type is useful if you don’t have software 
that can read Excel fi les (this format does not contain any 
of the raw sensor data). Th e data are organized in the fol-
lowing columns:
 • Measurement Time: Date and Time when the
  ProCheck made the measurement.

 • Sensor Name: Type of sensor used for the measure-
  ment.
 • Measurement 1: Primary measurement made by
  the sensor.
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 • Units 1: Units for measurement 1.
 • Measurement 2: Some sensors support two mea-
  surements.
 • Units 2: Units for measurement 2.
 • Measurement 3: Some sensors support three mea-
  surements.
 • Units 3: Units for Measurement 3.
 • Sample ID: Th e optional annotation saved at the 

 time of measurement. 

 Raw File (comma delimited) (*.csv): Th is fi le format con-
tains just the raw data as stored by the ProCheck. Save this 
type of fi le if you need to send a raw fi le to Decagon to help 
in troubleshooting a data processing problem.

Data File Options
ECH2O Utility has several user preference options that 
help you control how your data fi les are created. Th ese 
options only apply to the Excel Workbook and Processed 
Data Text fi le formats. To change these options, open the 
ECH2O Utility preferences by choosing Preferences from 
the Edit menu. 

Measurement Units: You can choose the units ECH2O 
Utility uses to present your data. For example, you can 
choose °C or °F for temperature measurements. Use the 
Measurement tab to set your preferred units. Data units for 
data fi les come from ECH2O Utility preferences, not the 
ProCheck settings.
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Column Headers: By default, ECH2O Utility writes col-
umn headers to your data fi le. You can turn this feature 
off  by deselecting this option in the Data File tab of the 
ECH2O Utility Preferences.

Date and Time Formatting in Data Files: ECH2O Utility 
uses the Windows operating system settings for formatting 
date and time information (Regional & Language Options 
control panel). You can override this formatting in the 
Data File tab of the ECH2O Utility Preferences.

More ECH2O Utility Options
In addition to downloading data stored in your ProCheck, 
ECH2O Utility helps you manage your ProCheck with the 
following options.

Setting the Date and Time
ECH2O Utility automatically synchronizes the date and 
time of your ProCheck to your computer time when you 
connect to your ProCheck. You can manually synchronize 
the time by selecting Set Date/Time from the Action menu.

Test Device  Firmware
If you think your ProCheck is not operating correctly, you can 
check the integrity of the fi rmware in your ProCheck. Firmware 
is the embedded software that controls how your ProCheck func-
tions. First, establish a connection to your ProCheck then choose 
Test Device Firmware from the Device Tools sub-menu in the Ac-
tions menu. Contact Decagon or your Decagon representative if 
your fi rmware has become corrupt.
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Check for Device Firmware Updates
You can use ECH2O Utility to check for updates to your 
ProCheck fi rmware. Choose Check for Device Firmware 
Updates from the Help menu to compare the fi rmware 
version in your ProCheck with the latest version available 
from Decagon. Your computer must be connected to the 
internet for this feature to work. Decagon can improve 
your ProCheck by publishing new versions of fi rmware to 
fi x bugs or add features.
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6. Troubleshooting

Th is chapter is in two sections. Th e fi rst section is  trouble-
shooting ideas for resolving issues when using your Pro-
Check. Th e second section is for troubleshooting software 
issues with ECH2O Utility.

Troubleshooting the ProCheck
To ensure operation of your ProCheck, please consider the 
following:

Batteries: Be sure your ProCheck has suffi  cient battery 
power. Th e ProCheck screen shows a battery icon in the 
upper right corner. When the battery power is low, replace 
the batteries. You can also use ECH2O Utility to check 
your battery power. Make sure you insert the batteries in 
the correct orientation when replacing them.

Sensors Plugged Securely: Check that your sensor connec-
tor is fully engaged with the connector on the ProCheck.

Correct Sensor Type: Be sure to select the correct sensor 
from the sensor menu on the main screen. Making mea-
surements with an incorrect sensor type selected will create 
incorrect measurements.
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Troubleshooting ProCheck Readings
PROBLEM: My ProCheck says “Above Range or “Below 
Range” in the display.

SOLUTION: Th e ProCheck is reading a value below (or 
above) the expected value for the sensor. Check to make 
sure the sensor is fully plugged in and the correct sensor 
type is chosen in the sensor menu.  Th is message could also 
indicate a broken sensor.  Contact Decagon for assistence.

PROBLEM: My ProCheck says “Invalid Response” or 
“No Response” on the display.

SOLUTION: Th e ProCheck is unable to communicate 
with a digital sensor. Check to make sure the sensor is fully 
plugged in and the correct sensor type is chosen in the sen-
sor menu. Try pressing the ENTER button several times 
to restart the sensor measurement. If these steps fail, the 
sensor is probably broken.

PROBLEM: Th e data shown for my ProCheck doesn’t 
seem correct.

SOLUTION: If you are using a custom calibration, be 
sure that the coeffi  cients are properly entered in the sensor  
confi guration menu. Check to make sure the sensor type 
shown in the sensor menu on the main screen matches the 
sensor type plugged into the ProCheck. If these steps don’t 
resolve the problem, please consult the sensor’s user manual 
for more information.
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Troubleshooting ECH2O Utility

Troubleshooting Serial Connections
PROBLEM: Th e ECH2O Utility tells me the communica-
tion port I want to use is in use by another application, but 
I don’t think any other programs are running.

SOLUTION: Some PDA synchronization programs mon-
itor serial communication ports. Disable Microsoft’s Ac-
tiveSync or Palm’s HotSync system software while trying to 
use the serial port with the ECH2O Utility.

PROBLEM: My USB-to-Serial adapter is not showing in 
the communication port picker.

SOLUTION: Enable “Force fi nd all Communication 
Ports” in the Preferences Menu by going to the Edit Menu, 
clicking Preferences, then the Communication tab, and en-
abling the check box at the bottom of the screen. Enabling 
this option may fi nd other serial ports that are not avail-
able for use by the ECH2O Utility (for example, modems 
installed in your computer).

PROBLEM: ECH2O Utility tells me it can’t connect to 
my ProCheck.

SOLUTION: Try one or more of the following to make 
sure there is a serial connection to your ProCheck.

 • Check your serial port choice. Make sure the “Con-
nect Via” drop-down menu shows the name of the se-
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rial port you are using to physically connect to your 
ProCheck. For example, if your ProCheck is physi-
cally connected to COM1, the “Connect Via” control 
should be set to “Direct on COM1 Communication 
Port”.

 • Check that your serial cable is securely plugged into  
   your ProCheck and your computer.

 
 • Make sure your ProCheck has good batteries.

PROBLEM: ECH2O Utility keeps reporting it lost the 
connection to my device.

SOLUTION: Please check or replace your serial cables. 
You can also increase the number of times ECH2O Utility 
tries sending commands to the ProCheck or DataStation. 
Increase the Direct Connect Retries on the Communica-
tion tab of the Preferences form.

Troubleshooting Data Issues

PROBLEM: ECH2O Utility tells me there is no data for 
downloading.

SOLUTION: Th ere is no measurement data stored in your 
ProCheck or previously saved data was erased. If you want 
to use measurement data collected by the ProCheck on 
your computer, be sure to press the SAVE button on the 
ProCheck after each measurement.
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PROBLEM: Some of the measurement data in my Pro-
Check data fi le shows “* * *”.

SOLUTION: Th e three asterisks means the data stored by 
the ProCheck is outside the expected range for the sensor 
type. Th is could indicate a broken sensor.

PROBLEM: My sensor data doesn’t seem correct.

SOLUTION: Th ere are many issues that aff ect the qual-
ity of the sensor measurement. Please see the user manual 
for your particular sensor for help troubleshooting the data 
collected by your sensor.
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Appendix A: Compatible Sensors

 Compatible Sensors
Th e ProCheck is only compatible with sensors made by 
Decagon. Th is chapter gives a list of compatible sensors.  
To learn more about individual sensors and their respec-
tive calibrations, please visit http://www.decagon.com/sup-
port/sensor-calibration-master-list.

Soil Water Content Sensors
10HS, EC-5 High Frequency Soil Moisture 
5TM Soil Moisture and Soil Temperature 
5TE, GS3, RS3 Soil Moisture, Soil Temperature, Soil EC

Soil Water Potential Sensors
MPS-2 Water Potential and Temperature Sensor
LWS Leaf Wetness Sensor

Temperature Sensors
ECT Air Temperature Sensor
RT-1 Rugged Soil Temperature Sensor

Rain Gauges
ECRN-50 Low Resolution Rain Gauge
ECRN-100 High Resolution Rain Gauge

Temperature and Relative Humidity Sensor
VP-3  Temp, Relative Humidity, & Vapor Pressure Sensor
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Radiation Sensors
PYR Solar Radiation Sensor
QSO-S PAR Photon Flux Sensor
SRS-Ni, SRS-Nr, SRS-Pi, SRS-Pr Solar Refl ectant Sensors

Wind Sensor
Davis Cup Anemometer
DS-2 Sonic Anemometer

Deep Drainage Sensor
G2/G3 Drain Gauge

Irrigation Switch
PS-1 Pressure Switch 

Miscellaneous Sensors
ECRN-50 Volume
Millivolt (0-3000 mv input)
Millivolt (0-1500 mv input)
Pulse Counter
Flow Meter
CTD Electrical Conductivity, Temp. & Depth Sensor
ES-2, ES-2F  Electrical Conductivity & Temp Sensor

Discontinued Sensors
EC-10, EC-20 Classic Soil Moisture 
EC-TM Soil Moisture and Temperature
ECH2O-TE Soil Moisture, Soil Temperature, Soil EC
MPS-1 Dielectric Water Potential Sensor
EHT Temperature/RH Sensor
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Appendix B: Sending Feedback
 
Decagon Software makes it easy to send feedback, bug re-
ports, and feature requests to Decagon or your Decagon 
Distributor. Choose “Send Feedback to Decagon...” from 
the help menu. Th is opens the window shown below.
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Enter your name, company name, and other contact in-
formation. Tell us what type of feedback you are sending 
(General Feedback, Feature Suggestions, Bug Report, or 
Other). Indicate how you want us to respond to your feed-
back (E-mail or Telephone).

Use the description area to give details for your feedback. 
If you are reporting a bug, it is very helpful for you to tell 
us what steps you took for the bug to happen and any error 
message you saw. By default, bug reports also include the 
software error fi les.

You can send Decagon a fi le using this form too. Th is is 
useful for sending data fi les that you have questions about.

If you work directly with a Decagon representative, put 
their E-mail address in the fi eld at the bottom of the form. 
Th is sends the contents of the form to them. Your Decagon 
representative can follow-up with you directly.
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ProCheck CE  Compliance

DECLARATION OF CONFORMITY

Application of Council Directive:        89/336/EEC

Standards to Which Conformity is  EN61326 : 1998
Declared:                                     EN55022 : 1998

Manufacturer’s Name:    Decagon Devices, Inc.

Type of Equipment:     ProCheck

Model Number:    PC-1

Year of First Manufacture:   2007

This is to certify that the ProCheck, manufactured by 
Decagon Devices, Inc., a corporation based in Pull-
man, Washington, USA, meets or exceeds the standards 
for CE compliance as per the Council Directives noted 
above. All instruments are built at the factory at Decagon 
and pertinent testing documentation is freely available 
for verifi cation.
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